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1. INTRODUCTION 
 

About this Document 
 
This document provides an overview of everything you need to do in order to: 
 

• Login & Logoff as a provider 

• Become familiar with your dashboard  

• Make a booking 

• Manage scheduling and availability 

• Create a report 

• Manage clients 
 
Details and information on setting up your bookitlive scheduling service can 
be found in User Guide 1: Setting Up Your Account. These guides are 
available both on the website (see the ‘Help’ page from your drop-down 
account menu) or in hardcopy form.   
 
 

 

Overview 
 
bookitlive is a web based online booking software delivered via the internet 
using a shared infrastructure on-demand model that, by design and 
architecture, reduces upfront costs and Total Cost of Ownership (TCO) as 
well as delivering increased business performance. 
 
It enables businesses to minimise their infrastructure and maintenance costs 
while accessing the latest technology and business solutions with access to 
frequent upgrades.  
  
The bookitlive web based application is classified as “Software as a Service” 
(SaaS) and is different from traditional software that needs to be installed on 
your PC.  
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Functionality 
 

• Online bookings 24/7 – clients can make, reschedule and cancel 
bookings at any time via the online public booking view  

• Phone & face-to-face bookings – take bookings over the phone or at 
your place of business and enter them manually via your provider view 

• Minimise no-shows – send notifications and reminders via email, 
SMS text and Outlook Calendar 

• Improve your resource/staff scheduling  – avoid overbooking by 
tracking all your bookings within the one system 

• Simplify processes – confirm and deny bookings with a click of a 
button 

• Immediate payment – take credit card payment at the time of booking 
using PayPal or SecurePay  

• View and manage bookings on the road – with a data connected 
smart phone (e.g. iPhone, Android) 

• Promote your business with ease – use client management features 
to promote your business to clients via email and SMS text message 

• Eliminate phone tag – reduce the number of calls you need to answer 
by directing your clients to make their bookings online 

• Create your own adhoc schedules – create flexible schedules for 
appointments outside of normal operating hours or define unique 
timetables for limited events 

 

 
 
 
 

Benefits of bookitlive SaaS model 
 

• No up-front costs  

• Lower total cost of ownership  

• No need for additional hardware or software 

• Greater level of support  

• No/Low maintenance requirement  

• Access to latest technology  

• More frequent feature (functionality) upgrades  

• Frees up staff to perform core business functions 

 



 

 5 

Public & Private Booking Views 
 
bookitlive offers a choice of views for managing your bookings – both public 
and private.  
 
The public booking view provides pages where your clients can make online 
bookings, and purchase packages and promotions themselves. By default the 
public booking view is visible to the public, but can be disabled if you do not 
want clients to make their own booking. 
 
See Public View Online/Offline in Section 2 for more details and information 
on how to activate/deactivate the public view settings.  
 
The details on your business dashboard are private and only visible to you 
and your assigned users (managers and staff members). You can elect to 
handle all your booking activities privately via your business dashboard. In 
this case you and your staff would take bookings and enter them in the 
system manually.  
 
 

Payment & Account Cancellation  
 

Payment Information 
 
bookitlive offers the following subscription payment options:  
  
•    Credit/Debit Card monthly payment 
•    Annual payment via card or invoice 
  
No payments are required during the free trial period, payment only occurs 
when the trial period has expired. 
  
bookitlive also offers discounts for upfront annual payments. (Contact 
info@bookitlive.net). 
 

Account Cancellation 
 
In the event that you wish to cancel your account you are solely responsible 
for following the online procedures for cancelling your account. This can be 
done from the Settings Menu in your dashboard. See Cancel Account in 
Section 2 of User Guide 1 for details. 
 
A cancellation fee can be charged to manually remove the account if you 
request cancellation by email or phone message. 
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2. BOOKINGS 
 
Now that you have configured your system (see User Guide 1: Setting Up 
Your Account) you undoubtedly wish to start making bookings. You can make 
manual bookings using features on your Business Dashboard or via the 
Booking Sheet page. This is also where you can view and edit bookings that 
you have taken manually or that clients have entered via your public booking 
view. 

 

 Login & Logout 
 
To login as a provider (Administrator/Manager/Staff Member): 
 

1. Browse to the bookitlive home page https://bookitlive.net 

2. From the top of the screen enter your email address and password 
NOTE: your password is case sensitive. 

3. Select the login button 

 
Once logged in your Business Dashboard looks like this: 
 
 
 

 

 Dashboard 
 
Once logged in your Dashboard looks like this: 

 
 

Business Dashboard 
 

Your Business Dashboard is the portal to all bookitlive features and 
configuration. 
 
From this page you can: 
 

https://bookitlive.net/
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• Access Tabs & Menus for account configuration, settings, tools and 
client management via the main menu 

• See all future bookings via ‘Next Bookings’ 

• Take phone and walk-up bookings via ‘Make a Booking’ 

• Access the booking sheet  
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Bookings 
 
Future bookings are visible on the left side of the Dashboard under. Selecting 
‘Show All Bookings’ will list all future bookings.  
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Booking Features 

A number of additional options are available from the ‘Next Booking’ view. By 
clicking on the booking icons on the right you can: 
 

Icon Function Description 

 Modify  Select this icon to modify a booking to a new date and time. 
A booking can also be modified to indicate its booking and 
payment status (see Status Indicators). 

 Repeat Select this icon to transfer client details to make a another 
booking.  

 Cancel A booking can be cancelled by selecting this icon.  
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 Go to client 
details 

Select this icon to open the client page with the client 
selected. If a booking is for a group all clients in the group 
will be selected. 

 View/Print 
Booking Details 

Clicking this icon opens a new page containing booking 
details in a print-ready format. 

Next Booking Icon Functions 

 
Status Indicators 
Information on the booking status and the payment status are also shown 
next to the booking. Status indicators can be changed at any time for both 
future and past bookings through the ‘Modify’ booking function. The data can 
also be exported to an Excel (CSV file format) from the Reports page. 
 

• Booking Status Indicator  
When a booking is added it is automatically set to a booking status of 
‘Scheduled’. The booking status can be changed by modifying the 
booking and changing the status to one of the following: 

Booking Status Indicator 

Completed  

Did not show  

Outstanding  

Cancelled  

 

• Payment Status Indicator 
When a booking is added it is automatically set to a payment status of 
unknown if no payment was taken. If a payment occurred at the time of 
booking the payment status will be set to ‘paid’. The payment status 
can be changed by modifying the booking and changing the status to 
one of the following:  

Payment Status Indicator 

Unknown  

Paid  

Not paid   

Refunded   

Forfeited   

 
  
 
 

• Availability Indicator 
A number shows next to the client booking to indicate how many of that 
particular service/resource are booked and how many remain.  
 

• Client Notes 



 

 11 

Click on the ‘Client Notes’ icon to access any additional notes about 
the client that were entered during booking. 

 

Make a Booking 
 
The ‘Make a Booking’ function (on the right of the screen) allows you to add 
new client details or edit existing client details without having to use the Client 
Management page. You can add or edit client details whenever you like, 
without having to make a booking. The ‘Make a Booking’ view provides all the 
functionality of the public booking view, including the ability to fill in forms 
associated with the service being booked. 
 
To make a booking you need to first select the client you wish to book for or 
create details for a new client. 
 
Add New Client 
When you click on the ‘Add New Client’ button a pop-up form appears ready 
for you to fill in the client details. In addition to taking the Client name and 
contact details, you can also record their date of birth, job information and 
Skype ID. For communication purposes you can set Email and SMS 
Notifications as well as sign them up to receive newsletters and special offers. 
You can also enter any additional Notes about the client.  
 
NOTE: In order to have the option of setting confirmation and notification 
options you will first need to configure your Notification Settings (see User 
Guide 1: Notification Settings). 
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Client Details Form  

Once you have completed the form you can click the ‘Create Account’ button. 
Now you’ll be able to ‘Select your Client’ to start your booking. 
 
NOTE: As a minimum only the mandatory fields are required to be entered. 
 
Select a Client 
When you click on the Select a Client bar a drop-down menu appears with a 
list of existing clients and a search box. Click on your selection and their 
details will appear below the bar on the screen. Now you can edit their client 
details or proceed to ‘Make a booking’.  
 
NOTE: Once you have over 1000 clients the “select a client” changes to 
search for a client similar to your client page. This occurs to reduce the 
amount of data loaded each time the Dashboard page is refreshed. 
 
Edit Client Details 
Clicking on ‘Edit Client Details’ brings up the same ‘Client Details’ form that 
appears when you create a new client (see Client Details Form). 
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Make Booking 
When you select the green ‘Make a Booking’ button a new window opens with 
the name of your business and the name of the client. Select the service the 
client wishes to book from the drop-down list of your services and the 
description of that service will appear. A ‘Location’ menu will appear with the 
possible locations associated with the service. You can now scroll through the 
calendar to select a date. Available times for booking will be shown for each 
of the dates you select.  
 
NOTE: In order to be able to make a booking you need to have first defined 
your services and location/s, assigned a resource to them (see the 
Configuration section in User Guide 1) and configured your available times 
(see Opening Hours in User Guide 1). 

 

 Calendar 
 
The calendar is an alternative area where you can add and manage all your 
manual bookings. You can access the Calendar from the Calendar tab from 
your dashboard. The Calendar lists all the bookings for a particular date and 
the availability of each of your resources.  
 
You can use the Calendar to: 
 

• Add a booking or block out time by selecting a green timeslot 

• Add a schedule or define non-working days via the toolbar option (see 
Section 3 Schedules for more information) 

• Navigate to different months and days with the calendar toolbar 
 
The Calendar can be filtered by Resource and Service to reduce the amount 
of data being displayed. 
 

 
Calendar View  
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3. SCHEDULES 
 

The booking process uses resource schedules to determine what dates and 
times are available to be booked. Once availability is defined the resource will 
be available to be booked for the scheduled times. Availability is defined using 
a resource fixed recurring schedule or by adding individual flexible schedules. 
Scheduling functions are found under the ‘Tools’ tab on the Dashboard Main 
Menu, but can also be accessed via the link in the Booking Sheet.  

 

Schedule Types 
 

Fixed Schedules 
 
Business that use a fixed schedule need the ability to define time slots and 

days when their resources are unavailable or business is closed. A resource 
fixed schedule (operating hours) is used when the resource operates the 
same hours every week (week 1) or fortnightly (week 2).  These schedules 
are ongoing with the availability reoccurring week after week.  
 

Flexible Schedules 
 

Typically flexible schedules are used for events, training courses and tours 
where only a small range of dates are required. Flexible schedules can also be 
used for casual staff that only work occasionally or to add extra time for a 
resource with a fixed schedule. 
 
Businesses that only use a flexible schedule do not have to block out time as 
they only need to define the time they are available and all other times are 

then unavailable. When a resource only uses flexible schedules a schedule 
needs to be defined for all dates and times that they are available. All other 
times are unavailable. 
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Split Schedules 
 

Split schedules are used in a daily schedule to cater for breaks and enforcing 
service start times. 
  
NOTE: Bookings cannot be made for a resource outside of the resource 
operating hours unless you define a flexible schedule. (See Resources in User 
Guide 1 for information on setting flexible schedules). 
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Adding Schedules 
 

When you click on ‘Add Schedule’ a pop-up screen will appear as an overlay 
over the Calendar page. This allows you to create a new schedule for a 
resource at a specified date and time. The schedule will override any existing 
schedule unless a booking is present. 
 

 
On the form you will need to fill in the: 
 

• Date • Resource 
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• Service 
• Start Time 

• End Time 

 
 
NOTE: A fixed and flexible schedule can be used together to cater for 
recurring and individual scheduling requirements. 
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 Removing availability 
 

A Business that uses a fixed recurring schedule needs the ability to remove 
availability for whole days and times within a day when their resources are 
unavailable or the business is closed.  

 

Removing availability 
 

From the Tools menu select “Remove Availability” This feature is used to 
restrict the ability to make bookings for a full day or range of days against 
your fixed recurring schedule.  
 

 
  
 
 
Remove availability for the following reasons: 
 

• Your business is closed for holidays (Public holidays/Bank Holidays 
etc.). This restricts the ability to make bookings for the entire business. 
 

• A resource is away for a full day or multiple days (training day, annual 
leave). This restricts the ability to make bookings for a particular 
resource. 

 
NOTE: Removing availability does not remove any existing bookings. You 
need to move or cancel existing bookings to inform your customers that you 
are unavailable on these days. 

Removing availability 
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On the form you will need to fill in the: 
 

• Resource  
• Date Range 
• Notes 

 
NOTE: The Remove availability page displays all the days and times where 
availability has been removed. 

 

 
Remove available time 
 
There will be certain times during a day when you want to restrict the ability 
to make bookings (make times unavailable) for a particular resource against 
their fixed recurring schedule.  
  
Use ‘Remove Availability’ to take away time periods within a day from your 
fixed recurring schedules to cater for breaks and times when the resource is 
not available.  
 
From the Calendar select a green time slot a pop-up screen will appear over 
the Calendar page.  
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Use the Remove Availability from the Tools menu to remove availability for a 
whole day or range of days. 
 
NOTE: Removing available time can only be defined on a fixed recurring 
schedule.   
  

Steps: 
 

1. From the top of the screen select “Remove time from availability” 

2. Select the start time from the drop-down menu 

3. Select the end time from the drop-down menu 

4. Save by clicking on the Save button. 
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4. REPORTS 
 

The Reports function is used to select booking details that you want to view 
and download to create your own reports. It is accessed via the Reports tab 
on the Main Menu. You will be able to define the booking search options for 
viewing and exporting booking details to a CSV file.  
 

Creating Reports  
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Creating Reports  

 
The table below shows all the data fields that can be used in compiling 
booking reports. (Set your fields in Settings - Client Preferences).  
 

Column Selection Field Description 

Booking Group Booking reference number to combine a multiple person 
group booking. 

Booking ID(s) Booking reference number for each person booked 

Member ID Bookitlive unique logon ID 

First Name* Client’s first name 

Last Name* Client’s last name 

ID* Client ID reference 

Company* Client’s company 

Address 1* Client’s address line 1 

Address 2* Client’s address line 2 

City/Town* Client‘s city of residence 

Region/State/Province* Client’s region or state of residence 

Postal Code* Client’s postal code 

Mobile phone* Client’s mobile phone number 

Phone* Client’s telephone number 

Email Client’s email address 

Date of birth* Client’s date of birth 

Booking Date The date and time of the booking 

Booking Created (GMT) The date and time in GMT the booking was created 

Booking Cancelled 
(GMT) 

The date and time in GMT when the booking was 
cancelled 

Service* The name of the service* that was booked 

Service Cost* The current service* cost 

Booking Condition  The name of the resource* that was booked 

Booking Cost The actual cost at the time of booking 

Resource* The name of the resource* that was booked 

Resource Description* The description of the resource 

Invoice Transaction receipt payment reference 

Voucher Code Voucher code entered at time of booking 

Security Code Security code entered at time of booking (Used for 
Groupon type deals) 

Booked By Person who made the booking 

Cancelled By Person who cancelled the booking 

Booking Status Currently set Booking status 

Payment Status Currently set Payment status 
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Notes Notes entered by the provider 

Booking Notes Client booking notes and combined custom form data 

 
*Field labels can be changed by setting the terminology for Settings - 
Terminology. 

 

Using Reports 
 

There are four different types of reports you can create: 
 

• Booking Report 
• Purchase Report 
• Voucher Report 
• Activity Report 

 
The same steps can be followed in making these reports. Of course, the field 
items in the ‘Show Column’ and the ‘Search Options’ differ according to 
whether it’s a Booking, Purchase, Voucher or Activity Report. 

 
 
 

Steps: 
 

1. Select the report tab – booking, purchase or voucher 
 

2. Choose columns – the column selection displays a list of fields in 
a box on the left-hand side. As you select them by ticking the check 
boxes they will appear in the box on the right-hand side in the order 
they will display in the report. You can use the All/None option to 
select or deselect columns in bulk. 
 

3. Select a Date Range – a drop-down list gives you your date range 
options. A custom date range can be selected via a calendar view. 

 
4. Select Search Options – the search options differ depending on 

which of the 3 types of reports you are creating 
 

5. Select Output Option – there are 2 different output options:  
 

o Screen – displays output to screen 
o Excel (CSV Format) – extracts data and downloads file 
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Creating Customised Reports 
 
The bookitlive system provides a great opportunity for you to tailor your 
reports for your particular business requirements. 
 
Once you have downloaded an Excel CSV file using the Reports Tool you can 
create your own reports by opening the file in Microsoft Excel. Excel can be 
used to filter data by resources, services or dates. 
 
If a business has custom forms attached to their account to capture additional 
information at the time of booking, the data will be stored in the Form Fields, 
one question per field.  
 
 
 

 Offline Backups 

The bookitlive software will generate a backup copy of your future bookings. 
Just click on Download Future Bookings to produce a document that can be 
saved on your computer. Alternatively use or Email daily booking summary 
to send your future bookings to the Administrators email. 
 

 
 

 
  

Backing up Future Bookings  
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5.  CLIENT MANAGEMENT 
 

Client Management provides features that make your business more efficient, 
increase your profitability, and reduce your operational costs. 
Your client management page looks like this: 

 

 
Client Management  

 
The action buttons are positioned on the left of the screen below your client 
search box. These features allow you to: 
 

• Contact clients via SMS or email 

• Export new client details to external file 

• Delete 

Benefits of maximising use of the client 
management features 
 

• Quick - Speeds up the manual booking process as you can select 
the client from a list and their details are automatically populated  

• Easy marketing - Allows you to send SMS text and email 
messages to a client or multiple clients to promote your business, 
advise of special offers or advertise your availability to attract 
more business 

• Simple record-keeping - Ability to export client details to other 
systems to build mailing lists and attract more business 

• Direct client communication - Encourage your clients to make 
online bookings by sending invites to use your online booking 
system 
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SMS Clients 
 
Text messaging your clients is a quick and easy way to communicate 
promotions and availability to your clients. SMS text messages can be sent to 
one client or multiple clients.   

 

 
Send SMS View  
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Email clients 
 
Email messaging your clients is a quick and easy way to communicate 
promotions and availability to your clients. Email messages can be sent to one 
client or multiple clients. 
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Email Message View  

 

Export Clients 
 
Use the Export feature to export all your client details to a file Excel file (CSV) 
and download the file. Open the downloaded file using a spreadsheet 
program like Microsoft Excel, or Open Office on a PC or Mac. 
 

 

Import Clients 
 
The import feature requires an Excel file (CSV) to be created with your client 
details. The file needs to be formatted as per bookitlive’s standards to import 
correctly. 
  
 
 
You can download an importing Excel file (CSV) template that includes an 
example on how to enter your client details. Alternatively contact bookitlive 
and we will help you with the client importing process. 

 

Add New Client 
 
Clicking on the ‘Add New Client’ button brings up the client record as on the 
Provider Dashboard view described in Section 2 Bookings. 

 
In addition to taking the Client name and contact details, you can also record 
their date of birth, job information and Skype ID. For communication purposes 
you can set Email and SMS Notifications as well as sign them up to receive 
newsletters and special offers. You can also enter any additional Notes about 
the client.  
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Client Record  

 
 
NOTE: In order to have the option of setting confirmation and notification 
options you will first need to configure your Notification Settings (see 
Notification Settings in User Guide 1). 

 

Send Invitation Requests 
 

When you add and modify your client details you have the option to invite the 
client to start using your Public Booking View to make online bookings. (The 
default value is off). When selected the system will send an email to the client 
inviting them to use your online booking system. An email will be sent to the 
client containing their log on details. The client will now be able to make 
online bookings using your businesses Public Booking View.  
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6.  VIEW 
 
The ‘View’ tab on the Provider Dashboard allows you to see the booking 
system the way a client would see it, whether that is using a mini-website, 
public booking view or product purchase page. 
 

 Public Booking  
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 Mini Website  
 
If you wish to add logos and business images to your mini-website see 
‘Account Images’ under ‘Settings’. 
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 Products  

 

 
Products View 
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7. ADD bookitlive to iPhone/iPad 
 
bookitlive can be added to your Home Page on a iPhone  or iPad.  
 

1. On your iPhone/iPad, go to a https://bookitlive.net/ page in Safari 

2. Tap the Add  button on the bottom of your screen to open the add 
menu 

3. Tap "Add to Home Screen" 

4. Type bookitlive as the name for the icon 

5. Tap "Add" to put it on your home screen 

6. Access bookitlive from your home screen by tapping the bookitlive icon 

 
 
8. ADDITIONAL ASSISTANCE 
 
Now that you’ve finished this module and are familiar with Booking 
Management you can take advantage of all the benefits offered by the 
bookitlive online booking software. 
 
 

For more information and help see the bookitlive Help Centre by 
selecting the in your dashboard or browsing to 
https://help.bookitlive.net 
 

You can ask question or raise support tickets from the Help Centre. 

 
 


